
 1 

HP Service Manager 

for supported Windows® and UNIX® operating systems 

Release Notes 

Software version: 7.11.462 Patch 18 / December 2011 

This document provides an overview of the changes made to HP Service Manager for 7.11.462 Patch 18. It 
contains important information not included in the manuals or in online help. 

Documentation Updates ......................................................................................................................... 2 

In This Version ........................................................................................................................................ 3 
Enhancements ...................................................................................................................................................... 4 
Web client updates ............................................................................................................................................... 5 
Windows client updates ....................................................................................................................................... 7 
Server updates ..................................................................................................................................................... 7 
Application updates ........................................................................................................................................... 13 

Known Problems, Limitations, and Workarounds .............................................................................. 13 

Installation Notes .................................................................................................................................. 14 
Web Tier installation ......................................................................................................................................... 15 
Windows client installation ............................................................................................................................... 15 
Server installation ............................................................................................................................................. 16 
Application unload installation ......................................................................................................................... 16 

Additions to the Documentation ........................................................................................................... 18 
Deploy the Service Manager Web tier on WebSphere 6.1 ............................................................................... 18 
Prepare array data for Web services integrations ........................................................................................... 19 
Blocking attachments with certain file extensions .......................................................................................... 19 

Verified Environments .......................................................................................................................... 24 

Local Language Support ....................................................................................................................... 24 

Support .................................................................................................................................................. 25 

Legal Notices ......................................................................................................................................... 26 



 2 

Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 
http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals�
http://h20229.www2.hp.com/passport-registration.html�
http://www.adobe.com/�
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In This Version 

Service Manager Version 7.11, build 462 patch 18 (SM 7.11p18) includes several customer requested 
software enhancements and fixes. Refer to the sections below for information about the defects and 
enhancements for each release included in this cumulative patch. 

Service Manager 7.11 patch 18 updates the following areas: 

• Enhancements 

• Web client updates 

• Windows client updates 

• Server updates 

• Application updates 

• Additions to the Documentation 
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Enhancements 

The following enhancements are included with this software release. 

Global ID Module Problem  Solution  

QCCR1E64278 
QCCR1E64285 
QCCR1E64290 
QCCR1E67610 

Web client 
Windows client 
Server 
Application 

Service Manager does not 
enable you to block 
executable files from being 
submitted as attachments.  

To prevent potentially dangerous 
executable files from being submitted 
as attachments, Service Manager now 
provides support for blocking certain 
types of attachments submitted 
through the Windows and web clients, 
as well as through web services, based 
on a pre-defined list of blocked file 
extensions.  
When users attempt to attach a file 
whose extension is in the list of 
blocked file extensions to a record, the 
clients disallow attaching the file and 
display an error message; when a web 
service transaction submits or 
retrieves a file as an attachment 
whose extension is included in this 
list, the server appends ".UNSAFE" to 
the submitted or retrieved file name. 
To take advantage of this 
enhancement, you must install all of 
the following: 

• The Windows client update for this 
release (QCCR1E64285) 

• The Web Client update for this 
release (QCCR1E64278) 

• The server update for this release 
(QCCR1E64290), including the 
supporting application unload file, 
QCCR1E67610_SM711P18.unl.  

For more information see Additions to 
the Documentation. 
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QCCR1E70811 Server Need to enhance the login idle 
status control for the web 
client. 

Introduced a new parameter "-
loginWaitTime:n", which defines the 
maximum idle time (in seconds) 
allowed for the login page. If the user 
stays on the login page longer than the 
time specified, a logout page will be 
returned when the user clicks the 
login button. 
The default value of this parameter is 
180 seconds (3 minutes). If an invalid 
value (negative, zero, or non-numeric 
value) is specified, the default will be 
used. 
To set a value other than the default, 
specify loginWaitTime:n in sm.ini or 
in the server's operating system 
command prompt, and then restart the 
server. 

QCCR1E54726 Server Modify Login/Module license 
tracking in Horizontal 
Scaling to improve log-in 
performance and reduce 
jgroups traffic. 

Redesigned license tracking in Service 
Manager horizontally-scaled 
environments to reduce synchronous 
jgroups communication. 

QCCR1E67744 Documentation The Service Manager 
documentation does not state 
that when integrating other 
applications with Service 
Manager through web 
services, array data should be 
broken into multi elements by 
separator "\r". Failure to do 
so could cause problems. For 
example, even if a 
configuration item (CI) is not 
changed, Service Manager 
always updates a change 
request, since the CI is stored 
in the Service Manager 
database as utf-8 while in 
UCMDB it is encoded as 
base64. 

Provided information on how to 
prepare array data when integrating 
other applications with Service 
Manager through web services.  
For more information see Additions to 
the documentation 

QCCR1E62170 Documentation The Service Manager Web 
tier failed to connect to the 
server when deployed on 
WebSphere (WAS) 6.1. 

Users should follow the correct steps 
to deploy the Service Manager web 
tier on WAS 6.1.  

For more information, see Additions to 
the Documentation. 

Web client updates  

The following items are fixed in the current software release.  
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Global ID Problem Solution 

QCCR1E49112 Performing a 'Fill All' on a large 
quantity of records was significantly 
slower on Internet Explorer than on 
Firefox. The performance is so slow that 
the browser becomes unresponsive and 
the following warning is displayed: 

Stop running this script? 

A script on this page is causing 
Internet Explorer to run slowly. 
If it continues to run, your 
computer may become unresponsive.  

The problem has been resolved, so that 
performing a 'Fill All' on a large quantity of 
records will complete successfully.  

Note: Users need  to disable spell-checking by 
setting the <showSpellCheck> parameter in 
the web tier’s web.xml to "false."   

QCCR1E49293 When adding an attachment that 
exceeds the size specified in the System 
Wide company record, a web client user 
logged in with a language other than 
English recieves an error message in 
both English and the user’s login 
language. For example, in French and 
English (the English message 
underneath): 

"Erreur de Telechargement du 
fichier"  

"File is too large (4622547). The 
maximum upload size is 15000". 

The message has been localized to the user’s 
login language. 

QCCR1E55936 When the user submits a Service 
Catalog request for an item that 
requires more than one approval 
activity, only one approval record is 
shown in the web client. 

The web client correctly displays all approval 
records.  

QCCR1E57635 After a binary upgrade from Service 
Manager version 7.10 to version 7.11, 
some forms are in a poor layout when 
viewed in Internet Explorer. 

Fixed the following problems so that the forms 
have a good layout when viewed in Internet 
Explorer: 

• A HtmlViewer widget overflows its 
fieldset widget in Internet Explorer.  

• When the caption of a fieldset widget is 
too long, it overflows the fieldset widget. 

QCCR1E62049 When deploying the web tier, in the 
sm.log an XSLT compilation error is 
displayed for <webtier>\WEB-
INF\templates\topaz\datetime.xsl. 

The XSL file has been formatted correctly, so 
the compilation error no longer occurs. 

QCCR1E62847 When viewing a form 
(svcCat.Display.item) from "Order from 
Catalog" in Service Catalog, a multi-line 
text box does not align correctly in the 
web client. 

The dynamic form is now rendered as a two-
column 50/50 split layout: The multi-line text 
box spans two columns if the label is empty, 
while gets only half of the widget width if the 
label is not empty. 
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Global ID Problem Solution 

QCCR1E62935 The size of the list builder was too small 
when adding a new delegation in  
Firefox.  

The size of the list builder when adding a new 
delegation in Firefox is the same as in Internet 
Explorer. 

QCCR1E63601 Attachments that have umlauts in 
filename cannot be opened.  

Attachments with umlauts in their file name 
can now be opened.  

QCCR1E65883 When a user connects to Service 
Manager through Trusted Sign-on 
(TSO) and the maximum number of 
concurrent logins is exceeded, there is 
no message sent to the user.  

When a user logs in through TSO and the 
maximum number of concurrent logins is 
exceeded, the following message is displayed: 
"Login failed. Maximum active logins for this 
user exceeded."  

QCCR1E66617 After adding an item in an item catalog, 
the add dependency command link was 
missing. 

After adding an item in an item catalog, the 
add dependency command link displays. 

Windows client updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E32374 If you attach a file to a Knowledge 
Management document where the 
dollar sign ($) is in the filename, you 
will not be able to open the 
attachment.  

Now you can attach a file with any of the 
following characters in the file name and 
open it with no problems: $, +, ( ), [ ], { }, 
and ^. 

QCCR1E60369 The Windows client crashes due to a 
memory leak when users view forms 
that contain a large number of 
Dynamic View Dependency (DVD) 
fields.  

The memory will be released, which will 
alleviate the errors that caused the crash.  

QCCR1E65709 The tab order is not followed, if using 
a Data Change Event on a combo 
box.  

If Tab is pressed on a combobox, it will not 
start Data Change Event so that the focus 
of the form will not change.  

QCCR1E69031 The old style menus display as 
notebooks instead of sections.  

The old style menus display as sections.  

Server updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E31869 Service Manager running in a horizontally- In horizontally-scaled environments, the 
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Global ID Problem Solution 

scaled configuration is not honoring the max 
login sessions configured in an operator 
record, and instead allowing more sessions 
for a given operator.  

max login sessions configured in an 
operator record is now enforced so that 
when sessions exceed the configured 
value, they are denied. 

QCCR1E31923 Client thread crashes when the data length 
exceeds the size defined in the database.  

The client will no longer crash when data 
length exceeds the defined size in the 
database.  

QCCR1E48956 Web Services clients that connect to Service 
Manager using a persistent connection show 
up in the System Status as Device ID:  
"Soap-". A System Administrator is unable to 
kill Web Services, based on the connections 
or clients using the "k" command in System 
Status. 

The Service Manager server now polls an 
action from the client request queue, and 
then checks the terminating status every 
3 seconds. This allows the current session 
to be terminated by the "K' command or 
the inactivity timer.  

QCCR1E51148 On Linux, throwing an exception might not 
be caught properly when C modules are 
involved.  

Changed the C modules to C++ modules 
so that the exception can be caught.  

QCCR1E55219 The connection restrictions do not work on 
Linux. A System Administrator is unable to 
quiesce the Service Manager system in a 
Linux environment. 

The connection restrictions are now 
working well on Linux. 

QCCR1E57292 Resource lock cannot be released or even 
cannot be killed using the 'k' command due 
to a plugin termination failure, even though 
the operator has logged out and the session 
does not exist. 

Added an exception handler for the plugin 
termination procedure so that Service 
Manager can clean up successfully when 
the operator is logged out. 

QCCR1E58163 Service Manager (SM) background processes 
defined in the sm.cfg fail to start if their log 
path contains spaces. 

SM bckground processes defined in the 
sm.cfg file now start successfully even if 
their log path contains spaces. 

QCCR1E58648 When Service Manager acts as a web service 
client, the doSoapRequest methods may time 
out and generate error messages that are not 
easily understood in the server log file 
(sm.log). 

Error or informational messages that are 
generated in the log as the result of a 
timeout when performing a 
doSoapRequest now indicate that a 
timeout has occurred.  

QCCR1E58862 The usergrid functionality does not work 
correctly when Service Manager is using an 
Oracle database. When the user attempts to 
open a saved column view by loading a 
named grid, the correct user grid may not be 
loaded. 

The usergrid functionality now works 
correctly. 

QCCR1E63830 When the user is searching for and viewing 
certain Knowledge Management (KM) 
documents, the system generates soap errors 

When the user is searching for and 
viewing certain KM documents, the 
WIN32 errors no longer occur. 
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Global ID Problem Solution 

which disconnect the Service Manager client, 
and a WIN32 exception or a Signal 11 occurs 
in the server log.  

QCCR1E65080 Even-numbered pages in the Print Preview 
for changes and associated tasks are blank. 

Cause: An extra page break was added 
which caused this issue.  

Service Manager checks the last line and 
inserts the page break properly.  

QCCR1E65135 When a record from a search that involved 
adhocsql files is updated and the updated 
record does not match the filter criteria, the 
record is not removed from the search list. 

When a record from a search that 
involved adhocsql files is updated, the 
record is removed from the search results 
if it no longer matches the filter criteria. 

QCCR1E65314 When performing an approval delegation in 
Service Request Catalog (SRC), a signal 11 
was caused by JavaScript (JS) called from a 
trigger.  

Calling JavaScript (JS) from a trigger no 
longer causes a Signal 11 error.  

QCCR1E65453 When trying to change the database field 
encryption key using the "sm -
changeencrkey" command, the command 
failed to complete and left the database 
corrupted.  

Users can successfully change the 
database field encryption key without 
error using the "sm -changeencrkey" 
command. 

QCCR1E65535 Column captions disappear after modifying 
the columns of a Configuration Item QBE 
list. 

Column captions no longer disappear 
after modifying the columns of a 
Configuration Item QBE list. 

QCCR1E65690 Need to improve debugdbquery:999 output to 
include information identifying specific 
records for FETCHes, INSERTs, UPDATEs 
and DELETEs, and include the return codes 
for all these operations. 

The debugdbquery:999 output now 
includes information identifying specific 
records for FETCHes, INSERTs, 
UPDATEs and DELETEs, and also 
includes the return codes for all these 
operations. 

QCCR1E65694 The process of parsing the IR stop words file 
could not be traced, so tailoring it could lead 
to unexpected results. 

Service Manager now allows tracing of 
the tokenization process, including during 
read of the stop words file. Trace is 
enabled by the already existing 
ir_trace:801 parameter. 

QCCR1E66003 When the Service Manager Server generates 
a huge XML document, it may run out of 
memory and does not catch this exception.  

The Service Manager Server now will 
catch the OutOfMemoryException, write 
the exception to the server log, and 
terminate the current client session. 

Note: Memory monitor thread must be 
disabled (by setting memorypollinterval:0 
in the sm.ini file) for this fix to work.  

QCCR1E66209 Client will exit when user chooses the Tasks, 
Changes, or Configuration Items queue and 
double-clicks a record.  

Client operations will be no problem 
when user chooses the Tasks, Changes, or 
Configuration Items queue and double-
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Global ID Problem Solution 

clicks a record.  

QCCR1E66690 Automated Testing: JavaScript unit tests 
need to be able to handle signals 
encountered by the RTE. 

When signals are encountered by the 
RTE during automated testing, the 
exception that is produced by the 
JavaScript can be caught by the 
JavaScript unit test. 

QCCR1E66747 JavaScript system.functions._null causes 
memory leak in Service Manager.  

Initialized the members of 
LocalRootAddScope with the passed in 
parameter, so that JavaScript 
system.functions do not leak memory.  

QCCR1E66812 In Service Manager (SM), when the SM 
administrator kills the scauto for OVO client 
(which is not the listener but the scauto for 
ovo user) in the System Status monitor, a 
message occurs indicating that the session is 
terminated, however it is not killed actually. 
The user session still exists on the server 
and the socket connection is still established.  

The SM administrator can kill the 
SCAuto client user session successfully 
using the "k" command, which means the 
user thread will be terminated on the 
server and the socket connection will be 
forced to be disconnected by the server. 

QCCR1E66852 In Linux and Solaris, signal 11 and core 
dumps might occur at start-up if the system 
resources were exhausted.  

In Linux and Solaris, if the system 
resources are exhausted, Service 
Manager process will not run into a 
signal 11.  

QCCR1E66855 RAD function fduplicate sometimes will 
return an invalid return value, even if it 
executes successfully when being called in 
JavaScript.  

Changed the behavior so that the RAD 
function fduplicate will not return an 
invalid return value when it executes 
successfully while being called in 
JavaScript.  

QCCR1E66886 A Javacore error occurs when uCMDB 
pushes data into Service Manager in multi-
thread mode.  

Changed the default value of the initial 
Java heap size to 192M. Service Manager 
will log a warning when the user provides 
a JVMOption heap size min or max 
greater than 512M.  

QCCR1E67061 When using Service Manager in French, the 
inactivity messages are not localized.  

When using Service Manager in French, 
the inactivity messages are localized.  

QCCR1E67071 The Knowledge Management update process 
(KMUpdate) causes an unnecessary load on 
the Service Manager (SM) server with 
approximately 15,000 to 20,000 extra logins 
per day. This, in turn, creates a lot of load on 
the Oracle database, licensing module, 
horizontally-scaled cluster communication, 
and many more. 

The KMUpdate process should have a 
companion KMStatusListener background 

Implemented a new background process 
(KMStatusListener) that replaces the web 
service listener and updates status and 
error knowledgebase records using 
Javascript. 
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Global ID Problem Solution 

process (which starts automatically on an as 
needed basis) and will update the status in 
SM without a need for a special web service 
servlet container. 

QCCR1E67101 Service Manager displays a stack trace after 
the "sm -version" command is run. 

Only the version information is displayed 
when the "sm -version" command is run. 

QCCR1E67121 When trying to modify the unique key of a 
table, the following error occurs and the 
indexes are not updated. 

Error: SQL State: 42S22-1911 Message: 
[Microsoft][ODBC SQL Server 
Driver][SQL Server]Column name 
'RECORD_KEY' does not exist in the 

target table.  

In this case, a full-table-copy will be 
performed.  

QCCR1E67233 If the backend RDBMS is not started or the 
wrong ODBC driver is used when executing 
the command sm -sqlverifyconnection, the 
console freezes and connection 'retry' 
information prints infinitely in the server log 
file (sm.log).  

After trying the connection three times 
and failing to connect to the RDBMS, the 
failure information will print in the log 
and the connection command will 
terminate.  

QCCR1E67300 In some horizontal scaling scenarios, new 
TRClient threads are launched while the 
parent process is being shut down.  

Service Manager processes now shut 
down cleanly. It no longer creates more 
TRClient threads while shutting down.  

QCCR1E67416 Using a JavaScript call in a conditional RAD 
expression on a decision panel causes an 
error message: "Assignment operator found 
while evaluating a condition!", even when 
the JavaScript call works properly.  

Using a JavaScript call in a conditional 
RAD expression on a decision panel will 
no longer cause an error message when 
the JavaScript call works properly.  

QCCR1E67848 The RAD select panel will always result in 
SELECT * issues against the RDBMS.  

The RAD select panel now provides a field 
that allows you to input the columns to be 
selected. (This is the RTE component of 
that support.)  

QCCR1E67910 The fourth parameter of RAD function 
generate.sql.query() will not take effect when 
a boolean value is passed, whether it is true 
or false.  

The fourth parameter will be taken into 
account when a boolean value is passed.  

QCCR1E67950 [Upgrade] Session crashed during load 
transfer. 

Session no longer crashes when users 
perform load transfer during an upgrade. 

QCCR1E68081 When trying to start Service Manager, users 
encounter a null pointer exception error:  

Exception in thread "main" 
java.lang.ExceptionInInitializerError 

Caused by: 

When checking for existence of the license 
file, Service Manager no longer generates 
the null pointer exception and will report 
the correct error statements in the sm.log 
file. 
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Global ID Problem Solution 
java.lang.NullPointerException 

at 
com.hp.ov.sm.common.auth.AutoPassClien
t.getFeatures(AutoPassClient.java:48) 

at 
com.hp.ov.sm.common.resource.LicenseDa
ta.verifyLicense(LicenseData.java:114) 

at 
com.hp.ov.sm.common.resource.LicenseDa
ta.initData(LicenseData.java:213) 

at 
com.hp.ov.sm.common.resource.LicenseDa
ta.initializeAutoPass(LicenseData.java
:66) 

at 
com.hp.ov.sm.common.core.Init.initiali
zeLicense(Init.java:347) 

at 
com.hp.ov.sm.common.core.Init.getInsta
nce(Init.java:147) 

at 
com.hp.ov.sm.common.core.Init.getInsta
nc 

 

Error! initializing java in scjvm.cpp 

In addition, error messages similar to the 
following appear in the sm.log file: 

26219( 1) 08/11/2011 16:06:55 JRTE I 
Java version: 1.6.0_21 

26219( 19) 08/11/2011 16:06:55 JRTE I 
Starting Memory Monitoring thread to 
check for memory every 15 seconds. 

26219( 1) 08/11/2011 16:06:55 JRTE E 
Autopass Initialization Failed. Error 
Code: 2013 Message: 2013 

26219( 1) 08/11/2011 16:06:55 RTE E 
Unable to Find Class 
com/hp/ov/sm/common/core/Init by 
ThreadId 1 

26219( 1) 08/11/2011 16:06:55 RTE D 
die: entered 

26219( 1) 08/11/2011 16:06:55 RTE E HP 
Service Manager is unable to start. 

QCCR1E68200 The displayed data List was incorrect after 
using Customize Current View when adding 
a field.  

The displayed data List will be correct 
when using the Customize Current View 
whether adding a field, or otherwise.  

QCCR1E69280 When an Employee Self Service (ESS) user 
accesses Service Catalog, the following debug 
message is written to the server log for every 
image displayed in the Service Catalog: 
"attachmentCompressed = false, Calling 
compress!" 

The attachment debug message will no 
longer occur unless the debugattachments 
parameter is enabled. 
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Application updates 

The following application update is included in the current software release.  

Global ID Problem Solution 

QCCR1E67072 Improve the Knowledge Management update 
process (KMUpdate) performance by removing 
the companion web service servletcontainer 
and adding a companion KMStatusListener 
Background process (which is started on 
demand without any administration).  

A new KMStatusListener process will 
start on demand without any 
administrative need and will update, 
delete, and insert documents into the 
relevant KM module tables. 

Important: To take advantage of this 
change, you must load 
QCCR1E67072_SM711P16HF8.unl, 
available in the patch_unloads directory. 

Known Problems, Limitations, and Workarounds 

This software release has the following limitation. 

Global ID Problem Workaround 

QCCR1E63663 The Service Manager (SM) client 
loses connectivity during 
JavaScript execution of the file.list 
RAD application.  

No workaround available. 

Created a knowledge article (KM1166532), 
which states that Service Manager does not 
currently support calls from JavaScript on 
RAD applications that use the rio/fdisp panels. 

Note: This information has been added to the 
HP Service Manager Programming Guide for 
the next version (Call a RAD application).  
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Global ID Problem Workaround 

QCCR1E57385 When Service Manager is running 
on Unix, the legacy listener may log 
intermittent signal 11 upon CIT 
initial connectivity test if exec-
shield is not set properly. 

Use one of the following solutions to solve this 
issue on Unix. 

Solution 1: 

Connect Connect-It to the Web Services 
connector instead of the Legacy Listener 
connector. 

Solution 2: 

Before connecting Connect-It to the Legacy 
Listener connector, do the following: 

1 Add  usethreading:0 in the sc.ini file, 
which is located in <Service Manager server 
installation 
path>\LegacyIntegration\RUN. 

 Note: For 64-bit RedHat Linux servers 
only, you can alternatively run the following 
shell commands as root: 

# sysctl -w kernel.exec-shield=0 

# sysctl -w kernel.randomize_va_space=0 

2 Start the legacy listener. 

QCCR1E69449 The user encountered a signal 11 
while updating an incident: RTE E 
Caught XML API exception 

scxmlapi(40). 

This is because another user was 
updating the probsummary dbdict 
record at the same time. 

When modifying a dbdict record, ensure that 
there are no other users updating records or 
inserting records in the same file. 

For example, when updating the probsummary 
dbdict, make sure that there are no other 
users updating existing incidents or opening 
new incidents. 

Installation Notes 

Before using patch 7.11.462 Patch 18 and all subsequent patches, you must manually remove the files listed 
below. 

Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar  

• saaj-api-2.1.jar 

• jgroups-all-2.5.0.jar 

Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 

• xalan-jaxp-1.3.2.jar 
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• jaxp-api-1.3.2.jar 

• dom-jaxp-1.3.2.jar 

• sax-jaxp-1.3.2.jar 

Web Tier installation 

The Web Tier update consists of a compressed file, sm711.462-P18_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. For more information, refer to the Service Manager Installation Guide. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. 

To install the Web Tier update: 

1 Back up your web.xml file, splash screen, style sheets, and any other customizations you made, including 
your webtier-7.11.war (.ear) file. 

2 Delete or uninstall the existing webtier-7.11.war (.ear) file. 

Note: The "Update Application" function in WebSphere Application Server 6.x allows you to redeploy 
using a new copy of webtier-7.11.war (.ear). First, update the web.xml in the webtier-7.11.war 
(.ear) file, and then redo the shared library configuration. For more information, see the IBM 
WebSphere documentation. 

3 Deploy the new webtier-7.11.war (.ear) file following the instructions in the Service Manager Installation 
Guide. 
 
Note: It is best practice to deploy with a unique context root. For example: /webtier-7.11.462 

4 Replace the new versions of any files you customized with your customized versions. 

5 Make any new customizations necessary for your deployment. Be sure to set the secureLogin and 
sslPort parameters. 

6 Restart the Application server. 
 
Note: Before accessing the new Web Tier, HP recommends that all users empty their browser cache. 

Windows client installation 

The client update consists of a compressed file, sm7.11.462-P18_Windows_Client.zip, which contains 
client.exe. 

To install the Windows client update: 

1 Stop the Service Manager Windows client. 

2 Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3 Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4 Check the version in Help > About Service Manager Client. The client should be Release: 7.11.462. 
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Server installation 

The server update for your operating system (OS) consists of a compressed file, sm7.11.462-
P18_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the [SM 
Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 

To install the Server update: 

1 Stop all Service Manager clients. 

2 Stop the Service Manager server. 

3 Make a backup of the RUN directory. 

4 Extract the compressed files for your OS into the main Service Manager directory on the server. The 
default path is:  C:\Program Files\HP\Service Manager 7.11. 

5 For UNIX servers, set the file permissions for all Service Manager files to 755. 

6 Remove the following files from the "\RUN\lib" directory:  

• saaj-impl-2.1.jar 
• saaj-api-2.1.jar 
• jgroups-all-2.5.0.jar 

7 Remove the following files from the "\RUN\lib\endorsed" directory:  

• xercesImpl-jaxp-1.3.2.jar 
• xalan-jaxp-1.3.2.jar 
• jaxp-api-1.3.2.jar 
• dom-jaxp-1.3.2.jar 
• sax-jaxp-1.3.2.jar 

8 Restart the Service Manager server. 

9 Restart the Service Manager clients. 

10 Check the version in Help > About Service Manager Server. The server should be Release: 7.11.462. 

Application unload installation 

The application consists of the unload files that come with the server update. When you extract 
sm7.11.462-P18_<OS>.zip (or .tar), it will add the new files to the following directory:  
[SM Root]\platform_unloads ([SM Root]/platform_unloads)  

To install the new applications, load the following unload files: 

• QCCR1E67610_SM711P18.unl, which enables you to block potentially dangerous attachments. For more 
information, see Blocking attachments with certain file extensions. 

• QCCR1E67072_SM711P16HF8.unl, which enables you to improve the Knowledge Management update 
process (KMUpdate) performance.  
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To load an unload file: 

1 Make sure the Windows client is configured for server-side load/unload.  

a) From the Windows client, go to Window > Preference > HP Service Manager.  

b) Unselect Client Side Load/Unload if is flagged.  

c) Restart the Windows client. 

2 Open Tailoring > Database Manager. 

3 Right-click the form or open the options menu and select Import/Load. 

4 Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5 Click Load FG.  
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Additions to the Documentation 

The following information supports updates included in this patch. 

• Deploy the Service Manager Web tier on WebSphere 6.1 

• Prepare array data for Web services integrations  

• Blocking attachments with certain file extensions 

Deploy the Service Manager Web tier on WebSphere 6.1 

To deploy the web tier on WAS 6.1, perform the following steps.  

Notes:  

• The steps are slightly different for Solaris and other platforms (Windows, Linux, and AIX). 

• The “x.xx” in the steps represents the Service Manager version, that is, 7.11. 

1 Copy or save the webtier-x.xx.ear file onto your local system.  

2 Update the webtier-x.xx.ear file by modifying the web.xml file contained in the webtier-x.xx.war file 
(which is packaged in the ear file). At a minimum, you need to set four parameters in the web.xml file: 
serverHost, serverPort, secureLogin, and sslPort.  

3 Re-archive the files in the ear file. Be sure to keep the original filenames and folder structure. 

4 Log on to the administration console of the WebSphere 6.1 Application Server with system privileges.  

5 Click Applications > Install New Application.  

6 Select Local file system and browse to your updated webtier-x.xx.ear file.  

7 Click Next. The file uploading starts. This may take quite a while. 

8 Click Next on each screen to accept the default settings until you reach the final step, and then click 
Finish. The installation of the web tier ear file begins. Wait until the installation completes.  

9 Click Save to save your configurations. 

10 Go to Enterprise Applications > HP Service Manager x.xx Web > Class loader, and make the following 
selections:  

- In the "Class loader order" section, select Classes loaded with application class loader first.  
- In the "WAR class loader policy" section, select Single class loader for application. 

11 Go to Enterprise Applications > HP Service Manager x.xx Web > Manage Modules > webtier-x.xx.war, 
and make the following selection: 

- In the "Class loader order" section, select Classes loaded with application class loader first.  

12 (For Solaris only) Add the javax.xml.transform.TransformerFactory system property to the JVM options:  

a Go to Application servers > server1 > Process Definition > Java Virtual Machine. 

b Add the following code to the "Generic JVM arguments" text box: -
Djavax.xml.transform.TransformerFactory=com.sun.org.apache.xalan.internal.xsltc.trax.T
ransformerFactoryImpl  

13 Click Save to save your local configuration changes. 

14 Go to Enterprise Applications > HP Service Manager x.xx Web, and click Start to start the web tier 
application.  
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15 When the application is successfully started, you can browse to the web tier login URL to launch the web 
client: http://<WAS_server_hostname>:<port>/webtier-x.xx/index.do 

Prepare array data for Web services integrations  

When integrating an application with Service Manager through Web services, array data should be broken 
into multi elements by separator "\r". This is because Service Manager uses "\r" as the separator between 
array elements. When a string that contains "\r" is retrieved from the Service Manager system, it is decoded 
as an array with multi elements separated by "\r". For this reason, when integrating other applications (for 
example, UCMDB) with Service Manager through web services, array data should be broken into multi 
elements by separator "\r" before the data is encoded and sent to the Service Manage system.  

For example, if an array contains elements "aabb" and "ccdd", it should be sent to Service Manager as the 
following: 

<ns:Comments type=\"Array\"> 

<ns:Comments mandatory=\"\" readonly=\"\">aabb</ns:Comments> 

<ns:Comments mandatory=\"\" readonly=\"\">ccdd</ns:Comments> 

</ns:Comments> 

Blocking attachments with certain file extensions 

To prevent potentially dangerous executable files from being submitted as attachments, Service Manager 
now provides support for blocking certain types of attachments submitted through the Windows and web 
clients, as well as through web services, based on a pre-defined list of blocked file extensions. At startup, the 
Windows and web clients retrieve the list of blocked file extensions, which is stored in the extensionstate 
table in the database. If no list is available, the clients use a default list. (For more information, see Default 
list of blocked file extensions.) 

To take advantage of this enhancement, you must install all of the following:  

• The Windows client update for this release (QCCR1E64285) 
• The Web Client update for this release (QCCR1E64278) 
• The server update for this release (QCCR1E64290), including the supporting application unload file, 

QCCR1E67610_SM711P18.unl.  

With these enhancements, Service Manager blocks the attachments in the following ways: 

• When users attempt to attach a file whose extension is in the list of blocked file extensions to a record, 
the clients disallow attaching the file and display the following error message: "File type: <filetype>, is 
not allowed as an attachment." 

• If the clients retrieve an existing attachment whose extension is included in the list of blocked file 
extensions, the clients append ".UNSAFE" to the file name to prevent the file from being automatically 
'run' on the user's machine. 

• During web services processing, if a transaction submits or retrieves a file as an attachment whose 
extension is included in the list of blocked file extensions, the server appends ".UNSAFE" to the 
submitted or retrieved file name. 

System Administrators can add, delete, and update records in the extensionstate table to customize the 
list of blocked file extensions. (For more information, see Customize the list of blocked file extensions.) 

If a Search Engine is installed and connected to the system, System Administrators must also update the 
sclib knowledgebase records, to include .unsafe to the list of file extensions that should be skipped for 
indexing. (For more information, see Add .unsafe to the list of file extensions to skip for knowledgebase 
indexing.) 
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Important: When your customization is complete, you must restart the web tier's web application server 
(for example, Tomcat, WebSphere) or restart the Windows client for the changes to take effect. 

Customize the list of blocked file extensions 

User Role: System Administrator 

You can add or remove files from the list of blocked file extensions based on the needs of your company. 

To view and customize the list of blocked file extensions: 

1 Open System Administration > Base System Configuration > Miscellaneous > File Extensions. 

2 Click Search.  
A list of file extension records displays. 

3 To add a new record: 

a Open an existing record. 

b Update the fields as follows: 

- File Extension: Type an extension without the dot character (.) For example, type "bat" rather 
than ".bat". 

- Unsafe: Check this box to block attachments with this file extension or uncheck this box to 
unblock them. 

- File Type: Type a description of this file type. 

c Click Add.  
The new file extension is added to the list. 

4 To update an existing record: 

a Select the record from the list. 

b Check or uncheck the Unsafe check box. 

c Click Save to save the record. 

5 To delete a record: 

a Select the record from the list. 

b Click Delete. 

c Click Yes to confirm the deletion.  
The record is removed from the list. 

6 Do the following for the changes to take effect: 

- Windows client: Log out and exit the client and then restart it. 
- Web client: Restart the web application server. 

Add .unsafe to the list of file extensions to skip for knowledgebase indexing 

User Role: System Administrator 

To prevent Service Manager from indexing unsafe attachments for knowledgebase searches, add .unsafe to 
the list of file extensions that should not be indexed or extracted. To do this, updating the following sclib 
type knowledgebases: Incident_Library, Interaction_Library, Knowledge_Library, Knownerror_Library, and 
Problem_Library. 

Note: This task requires that you have a search engine installed and correctly configured. 
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To update the knowledgebases: 

1 Open Knowledge Management > Configuration > Knowledgebases. 

2 Click Search. 
A list of records displays: Incident_Library, Interaction_Library, Knowledge_Library, 
Knownerror_Library, and Problem_Library. 

3 Select a record in the list, and open the Type information tab. 

4 In the Skip these extensions field, add .unsafe to the existing file extension list, using a semi-colon as 
the separator. For example, type: jpg;bmp;gif;exe;unl;unsafe. 

5 Click Save. 

6 For the other records in the record list, repeat steps 3 through 5. 

After you complete this, the files you indicated will be blocked from being submitted as attachments. 

Default list of block file extensions 

Service Manager blocks attachments whose file name extensions are included in a list of files retrieved from 
the database. If such a list is not available from the database, Service Manager blocks attachments with the 
file name extensions listed in the following table. 

File Name Extension Description  

.ade  Access Project Extension (Microsoft)  

.adp  Access Project (Microsoft)  

.app  Executable Application  

.asp  Active Server Page  

.bas  Active Server Page  

.bat  Batch Processing  

.cer  Internet Security Certificate File  

.chm  Compiled HTML Help  

.cmd  DOS CP/M Command File, Command File for Windows NT  

.com  Command  

.cpl  Windows Control Panel Extension (Microsoft)  

.crt  Certificate File  

.csh  csh Script  

.der DER Encoded X509 Certificate File 

.exe  Executable File  

.fxp  FoxPro Compiled Source (Microsoft)  

.gadget Windows Vista gadget 

.hlp  Windows Help File  

.hta  Hypertext Application  
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.inf  Hypertext Application  

.ins  IIS Internet Communications Settings (Microsoft)  

.isp  IIS Internet Service Provider Settings (Microsoft)  

.its  Internet Document Set, Internet Translation  

.js  JavaScript Source Code  

.jse  JScript Encoded Script File  

.ksh  UNIX Shell Script  

.lnk  Windows Shortcut File  

.mad  Access Module Shortcut (Microsoft)  

.maf  Access (Microsoft)  

.mag  Access Diagram Shortcut (Microsoft)  

.mam  Access Macro Shortcut (Microsoft)  

.maq  Access Query Shortcut (Microsoft)  

.mar  Access Report Shortcut (Microsoft)  

.mas  Access Stored Procedures (Microsoft)  

.mat  Access Table Shortcut (Microsoft)  

.mau  Media Attachment Unit 

.mav  Access View Shortcut (Microsoft)  

.maw  Access Data Access Page (Microsoft)  

.mda  Access Add-in (Microsoft), MDA Access 2 Workgroup (Microsoft)  

.mdb  Access Application (Microsoft), MDB Access Database (Microsoft)  

.mde  Access MDE Database File (Microsoft)  

.mdt  Access Add-in Data (Microsoft)  

.mdw  Access Workgroup Information (Microsoft)  

.mdz  Access Wizard Template (Microsoft)  

.msc  Microsoft Management Console Snap-in Control File (Microsoft)  

.msh Microsoft Shell  

.msh1 Microsoft Shell  

.msh2 Microsoft Shell  

.mshxml Microsoft Shell  

.msh1xml Microsoft Shell  

.msh2xml Microsoft Shell  

.msi  Windows Installer File (Microsoft)  

.msp  Windows Installer Update 
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.mst  Windows SDK Setup Transform Script  

.ops  Office Profile Settings File  

.pcd  Visual Test (Microsoft)  

.pif  Windows Program Information File (Microsoft)  

.plg Developer Studio Build Log 

.prf  Windows System File  

.prg  Program File  

.pst  MS Exchange Address Book File, Outlook Personal Folder File (Microsoft)  

.reg  Registration Information/Key for W95/98, Registry Data File  

.scf  Windows Explorer Command  

.scr  Windows Screen Saver  

.sct  Windows Script Component, Foxpro Screen (Microsoft)  

.shb  Windows Shortcut into a Document  

.shs  Shell Scrap Object File  

.ps1 Windows PowerShell 

.ps1xml Windows PowerShell 

.ps2 Windows PowerShell 

.ps2xml Windows PowerShell 

.psc1 Windows PowerShell 

.psc2 Windows PowerShell 

.tmp  Temporary File/Folder  

.url  Internet Location  

.vb  VBScript File or Any VisualBasic Source  

.vbe  VBScript Script File, Visual Basic for Applications Script  

.vbs  VBScript Script File, Visual Basic for Applications Script  

.vsmacros  Visual Studio .NET Binary-based Macro Project (Microsoft)  

.vsw  Visio Workspace File (Microsoft)  

.ws  Windows Script File  

.wsc  Windows Script Component  

.wsf  Windows Script File  

.wsh  Windows Script Host Settings File  

.xnk Exchange Public Folder Shortcut 
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Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  

1 Use a browser to navigate to the Software Support Online (SSO) Web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 7.11 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

http://support.openview.hp.com/sc/support_matrices.jsp�
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Support 

You can visit the HP Software support web site at: 

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html 

http://h20230.www2.hp.com/new_access_levels.jsp�
http://h20229.www2.hp.com/passport-registration.html�
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notice 

© Copyright 1994-2011 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

• Adobe™ is a trademark of Adobe Systems Incorporated. 

• Java™ is a registered trademark of Oracle and/or its affiliates. 

• Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

• Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

• UNIX® is a registered trademark of The Open Group. 

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 
web site and search for the product manual called HP Service Manager Open Source and Third Party 
License Agreements. 
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